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AKVIS HDRFACTORY 8.0 | HIGH DYNAMIC RANGE IMAGES: BRIGHTER THAN REALITY!

AKVIS HDRFactory is a versatile program for creating HDR images and making photo correction.

High Dynamic Range Imaging is a technique used to produce an image with high dynamic range.

The software makes HDR photos by combining several images of the same object taken with different exposure values.

The result is an expressive contrasting image that reflects reality with a higher level of authenticity than a simple snapshot.

By comparison, the human eye discerns many more nuances of color and brightness than any modern camera could record.
The HDR technology endeavours to bridge the gap between reality as we see it and its photographic reflection.

The name of the program can be taken literally, as HDRFactory is a real workshop for the production of fascinating HDR
images.

With the software you can come very close to reality and even go beyond it by creating stylized images with fabulous colors
and unique effects.
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AKVIS HDRFactory can also imitate the HDR effect on a single image, by creating a so-called pseudo-HDR.

This technique is useful if you don't have a series of images with different exposures. Just load a single image into AKVIS
HDRFactory and admire the effect which goes beyond photo realism and opens the door into the fascinating world of HDR!
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The program can also be used for photo correction. You can adjust color saturation and brightness, and bring out the detail in
dark and bright areas.

AKVIS HDRFactory brings life and color to your photos!
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It's fast and easy to make an ideal High Dynamic Range photo in the program: combine images into one HDR image, and if
necessary, apply additional correction and effects.

The program offers a number of the ready to use AKVIS presets. You can also create your own presets by saving frequently
used settings. This feature optimizes your work and saves you time.
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Advanced licenses (Home Deluxe and Business) offer additional features. They include the Ghost Removal tool that helps to
repair the so-called "ghosts" that sometimes appear in an HDR image and the Local Correction tool which helps to refine the
result on certain areas.

 

AKVIS HDRFactory is available in two versions - as an independent program (standalone) and as a plugin to a photo editor.
The plugin is compatible with AliveColors, Adobe Photoshop, Corel PaintShop Pro, etc. Check the compatibility.

The standalone application also lets you use the Post Processing settings to adjust brightness, contrast, gamma, and
saturation of the image, and the Crop tool to improve the composition.

The plugin version supports Batch Processing with actions (when making an HDR effect on a single image) that lets you
automatically process a lot of images.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or
re-run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> HDRFactory, in AliveColors: Effects -> AKVIS –> HDRFactory.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-hdrfactory-app.dmg to install the Standalone version

- akvis-hdrfactory-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS HDRFactory application or AKVIS HDRFactory PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS HDRFactory app into the folder Applications (or any other place
you like).

To install the Plugin, drag the entire AKVIS HDRFactory PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. Select in Photoshop:
Filter -> AKVIS -> HDRFactory, in AliveColors: Effects -> AKVIS -> HDRFactory.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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INSTALLATION ON LINUX

Follow the instructions to install the AKVIS software on a Linux computer.

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using
the uname -srm command.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys: 

sudo mkdir -p /usr/share/keyrings
3. Download the key that signed the repository: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
or wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Add the repository to the list where the system looks for packages to install: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Update the list of known packages: 
sudo apt-get update

6. Install AKVIS HDRFactory 
sudo apt-get install akvis-hdrfactory

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command: 
sudo apt-get upgrade

To remove the program: 
sudo apt-get remove akvis-hdrfactory --autoremove

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository: 

sudo rpm --import https://akvis.com/akvis.asc
3. Add the repository to the system: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Update the package list:

when using the dnf package manager: 
sudo dnf update

when using the yum package manager: 
sudo yum update

5. Install AKVIS HDRFactory:

when using the dnf package manager: 
sudo dnf install akvis-hdrfactory

when using the yum package manager: 
sudo yum install akvis-hdrfactory

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager: 
sudo dnf upgrade

when using the yum package manager: 
sudo yum upgrade

8. To remove the program:

when using the dnf package manager: 
sudo dnf remove akvis-hdrfactory

when using the yum package manager: 
sudo yum remove akvis-hdrfactory
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Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository: 

rpm --import http://akvis.com/akvis.asc
4. Add the repository to the system: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Update the package list: 

zypper ref
6. Install AKVIS HDRFactory: 

zypper install akvis-hdrfactory
7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates: 
zypper update

To remove the program: 
zypper remove akvis-hdrfactory

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS HDRFactory and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (HDRFactory.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).
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WHAT IS HDRI: ABOUT HIGH DYNAMIC RANGE IMAGING

When you shoot a scene comprising both a strong light source and deep shadows you will notice that details either in
shadows or in highlights get lost. Imagine you stay in a dark room and try to take a view outside the window - you will see
only one thing in detail - either the view or the room's interior. However, there is a method for keeping detail in every single
part of the image.

HDRI (High Dynamic Range Imaging) is a technology that expands the dynamic range of an image and shows details in
both shadows and highlights.

Dynamic Range is a range of brightness values that can be recorded on media (film, photographic plate, photographic
paper) or on the matrix of a digital camera.

In contrast to the modern cameras that have a low dynamic range, the human eye is able to discern many more tonal values
and sees details of any object at any lighting.

HDRI technology minimizes this discrepancy by combining several shots to get an image very close to what the photographer
sees with his eyes. However, monitors, just like cameras, have a lower dynamic range and can not render an HDR-image to
the best advantage. That is why a technology called Tone Mapping is applied to compress the dynamic range of an HDR-
image without degrading the image quality. The resulting image is called a LDR (low dynamic range) image, but it looks much
better than the original images.

The difference is evident if you take high contrast shots.

Compare the original shots:
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And the result of HDRI processing:

Earlier, one had to use gradient filters when shooting or various tools in Adobe Photoshop (masks, layers) to get a similar
image.

With the advent of HDRI technology the process has been simplified. Now it is sufficient to take a series of shots of one and
the same object using different exposure settings, then load the images into AKVIS HDRFactory and combine them into one
image.
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HOW TO GET SHOTS WITH DIFFERENT EXPOSURES

To generate an HDR-image you need a series of shots of the same scene taken with different exposures. It is possible to use
Manual mode or Automatic Bracketing mode.

Let's look at the second option in detail. Follow the instruction below to take a series of shots with different exposure
settings using automatic bracketing:

1. Set your digital camera to automatic bracketing mode (AEB). Generally, this mode allows you to take a series of three
shots: normal, underexposed and overexposed. Some digital cameras allow you to take a series of 5 and more shots.

2. Set the range of exposures for automatic bracketing. We recommend the following values: -2, 0,+2.
3. Set the ISO parameter to a value not higher than 100; otherwise, the shots may have too much noise, which is

difficult to handle.
4. Choose the maximum image size.
5. Select a subject for shooting. When shooting outside you can encounter some problems. The scene is rarely static. If

there are people and cars moving, wait till they leave the scene. As for leaves trembling in the wind, there is no way to
change it and it is not critical - it will not have a considerable impact on the result. If the trees themselves are shaking,
it is better to delay shooting the subject, as it may cause the branches to double on the final image.

6. Set the camera on a tripod or on a stable surface. If you fix the camera, shift when shooting will be minimized.
7. Take a series of shots.
8. Transfer the shots to the computer.

Attention! Do not alter the photos.

Photos with the exposure settings -2, 0 and 2
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WORKSPACE OF THE PROGRAM

AKVIS HDRFactory can work independently as a standalone program or as a plug-in to a photo editor.

Standalone is an independent program. You can run it in the usual way.

Plugin is an add-on for graphics editors, for example for Photoshop, AliveColors, and other compatible programs. To call
the plugin, select it from filters of your image editing program.

The AKVIS HDRFactory workspace looks like this:

The left part of the program's window is taken by the Image Window with two tabs: Before and After. In the Before tab
the original image is shown, while in the After tab you can see the processed image. You can switch between the windows
by clicking on a tab with the left mouse button.

You can select how Image Window and Before/After tabs will be shown by adjusting the View Modes in the bottom part
of the left panel.

 

In the upper part of the program's window you can see the Control Panel with the following buttons:

The button  opens the home page of AKVIS HDRFactory.

The button  opens an image or series of shots for processing. The hot-keys for the command are Ctrl+O  on

Windows, ⌘ +O  on Mac.

In the standalone version right mouse click on this button displays the list of recent files (single images or HDR-sets).
You can change the number of recent documents in the program's preferences.

The button  (only in the standalone version) saves an image to the disk. The hot-keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) opens the print dialog. The hot-keys are Ctrl+P  on Windows, ⌘ +P

on Mac.

The buttons  and  (only in the standalone version) let you rotate an image left or right by 90o. The hot-keys

are Ctrl+,  (to the left) and Ctrl+.  (to the right) on Windows, ⌘ +,  and ⌘ +.  on Mac.
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The button  (Deluxe/Business) activates the Ghost Removal mode.

The button  (Deluxe/Business) activates the Local Correction mode.

The button /  shows/hides the selected areas.

The button  cancels the last operation made with the tools. It is possible to cancel several operations in a row.

The hotkey for the command is Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The hotkey for

the command is Ctrl+Y  on Windows, ⌘ +Y  on Mac.

Note: The buttons / ,  are active only when working with selections in the Ghost Removal mode or in the

Local Correction mode.

The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series

of images.
The button  (only in the plugin version) applies the result and closes the plugin.

The button  calls information about the program and opens the registration window.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program's options.

The Button  opens a window showing the latest news about HDRFactory.

 

If several images are opened, their thumbnails are shown under the Image Window. The Before tab displays the image,
which is now selected (highlighted in blue). To display a different image, left-click on its thumbnail.

The check-box near the thumbnail indicates if the image will be used when generating the HDR-image. Deactivate the check-
box near the image with a left-click, if you do not want to use it when creating the HDR-image.

 

Тo the left of the image window there is the Toolbar:

Local Correction Tools (available only for Home Deluxe and Business licenses in the Local Correction mode ):

The button  activates the Pin Tool that allows you to process certain image areas by adding pins around which the

correction area with its parameters is created. The hot-key is P .

The button  activates the Correction Area tool that allows you to mark free-form image areas that require

additional processing. To adjust the processing parameters, click the selection with the right mouse button. The hot-
key is B .

The button  activates the Eraser tool to edit or remove selections made with . The hot-key is E .

Ghost Removal Tools (available only for Home Deluxe and Business licenses when working with a series of pictures in the
Ghost Removal mode ):

The button  activates the Ghost Removal tool which helps to get rid of defects that sometimes appear in HDR

images. Adjust the tool's options in a pop up window which is shown when right-clicking on the image. The hot-key for
the tool is G .

The button  activates the Eraser to edit or remove selections made with . The hot-key is E .

Additional Tools:

The button  (in the standalone program) activates the Crop tool for cutting off borders of the image and reducing

its size. The hot-key is Alt+C .

The button  activates the Hand tool which lets you scroll the image when it does not fit within the window at the

desired scale. Bring the cursor over the image, and while keeping the left mouse button pressed move in the desired
direction. The hot-key is H .

Double-clicking on the tool's icon  makes the image fit the window.
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The button  activates the Zoom tool which changes the image's scale. To zoom in click on the image. To zoom out

click with Alt . The hot-key for the tool is Z .

Double-clicking on the tool's icon  makes the image scale to 100% (actual size).

Navigate and scale the image using the Navigator. Here you can see the reduced copy of the image. The red frame shows
the part of the image that is now visible in the main window; the areas outside the frame will be shaded. Drag the frame to
make other parts of the image visible. To move the frame, place the cursor within it, left click the mouse, and then drag.

Additionally, you can move the image in the main window with the scroll bars or by holding down the space bar, then holding
down the left mouse button while moving the mouse. The mouse's scroll wheel can move the image up and down, and holding
Ctrl  on Windows, ⌘  on Mac – while using the scroll wheel will move the image left and right. Holding  Alt  on Windows,

Option  on Mac will scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider to scale the image in the window. When you move the slider to the right, the image scale increases. When you
move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field and pressing the button Enter  on

Windows, Return  on Mac. Frequently used scale coefficients can be found in a drop-down menu.

You can use hot-keys to change the image scale +  and Ctrl++  on Windows, ⌘ ++  on Mac to increase the image scale

and -  and Ctrl+-  on Windows, ⌘ +-  on Mac to reduce the scale.

Under the Navigator there is the Settings Panel where you can adjust parameters.

In the Presets field you can save favorite settings as a preset to use them in the future.

The Hints field will help you to understand how to use the program. The description for the parameters and buttons appear
when you hover over them with the cursor. You can choose where the hints will be shown or hide them in the program's
Preferences.
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IMAGE VIEW MODES: BEFORE AND AFTER

At the bottom of the Toolbar of AKVIS HDRFactory, there are three buttons which let you choose how the Image Window
will look like and arrange the Before and After tabs.

Click the first button to open a submenu that contains various options for viewing the original and processed images:

- The button  provides the standard image window mode with two tabs: Before and After.

- The buttons  and  divide the main window into two parts, vertically or horizontally, respectively. The

original and processed images become partially visible and the tabs are combined to form the whole picture.

With this arrangement, it's possible to drag the splitter changing the aspect ratio between the Before and After
parts.

- The buttons  and  split the main window into two parts, vertically or horizontally, as well. However, in

contrast to the previous option, the windows display the same fragment of the image before and after
processing.

Note: Use two windows side by side when you want to see and compare the original and processed versions of an
image fragment on one screen. If you would rather see the final image as a whole, you can choose the standard image
view mode.

The button  swaps the positions of the original image and result when displaying two windows.
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The 3rd button lets you choose the background color of the Image Window. Pressing , , or  changes the

background color to white, gray, or black, while clicking on  opens the Select Color dialog where you can choose a

color of your choice.
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HOW TO USE THE PROGRAM

AKVIS HDRFactory lets you create an HDR-image from a series of shots or from one single photo.

Follow the instructions below:

Step 1. Open an image or a series of shots.

- If you work with the standalone edition:

The dialog box Select Files to Open appears if you click on the button  on the Control Panel or using the

key combination Ctrl+O  on Windows, ⌘ +O  on Mac.

The program supports images in the JPEG, TIFF, BMP, PNG, WEBP, and RAW formats (CRW, NEF, ORF, PEF
etc - see the full list here). You can also drag the required image into the workspace of the program.

- If you work with the plug-in:

Open an image in your photo editor by calling the command File -> Open.

Call the AKVIS HDRFactory plugin in the Filter/Effects menu of the photo editor:

in AliveColors: Effects -> AKVIS -> HDRFactory; 
in Adobe Photoshop: Filter –> AKVIS –> HDRFactory; 
in Corel Paint Shop Pro: Effects –> Plugins -> AKVIS –> HDRFactory; 
in Corel Photo-Paint: Effects -> AKVIS –> HDRFactory.

In plugin as well as in the standalone edition, you can process one single image loaded from the image editor or
create an HDR image from the series of shots. To work with HDRI tab in the plugin you should open the full set of
photos by clicking on .

Step 2. Select the value of the Preview parameter.

The Preview parameter is an auxiliary tool, it does not influence the real size of the image. The original image will stay
the same and all details of the original image will be kept. This parameter speeds up the pre-processing stage when one
tries different settings to obtain the best result.

When the HQ option is selected, the processing parameters are applied to the image in its original size. The processing
time will increase but the preview quality will be as high as possible. If you select the Fast option, the preview size is
smaller than the original image by 8 times. The processing time will decrease accordingly, but the result will be
approximate. For intermediate values, the preview size is 2 and 4 times smaller than the original image.

Attention! Once you have adjusted the parameters, it is recommended to try the HQ processing to make sure
that the best settings are chosen.

Step 3. When you load a series of images taken with different exposures, the images will be opened to handle in the
HDRI tab.
Step 4. When a single image is loaded, it will be opened right in the Adjustment tab. Here you can make some
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correction or create an HDR look with one photo.

Also, here you can continue working with series of shots and apply additional processing to the High Dynamic Range
image which you got in 1st tab.

Step 5. Owners of the Home Deluxe and Business licenses can also use the Ghost Removal  and Local

Correction  modes.

Step 6. Using the Effects tab you can add a soft glow effect to the photo, darken or lighten the image edges, adjust
image hues, add warm or cold tints.
Step 7. If you like the new settings of the parameters, you can save them as a preset and use them later. To save the
settings, enter a name for the preset in the Presets field and press the button Save.

Note: The HDRI, Adjustment, and Effects tabs have the common list of presets. When a new preset is created
it will be available in all tabs and will contain all their settings.

When moving a cursor over a preset in the drop-down list, the quick result appears in the Preset Preview window.

To process the image with a certain preset, select this preset from the list. The image will be automatically processed
with the preset's settings.

Next time you launch the program, these settings will be used by default. If you change the parameters you can return
to the initial settings of the selected preset by clicking on Reset.

To delete a preset, select it from the list and click on the button Delete.
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Step 8. For further image correction you can use the Post Processing settings (only in the standalone version).
Step 9. In the standalone version, you can also print your result using .

Step 10. Save the resulting image.

- If you work with the standalone program:

Click on the button  to open the Save As dialog box. Enter a name for the file, choose the format (TIFF,

BMP, JPEG, WEBP or PNG) and indicate the target folder.

- If you work with the plugin:

Apply the result by pressing . The AKVIS HDRFactory plugin will close and the picture will appear in the

photo editor's workspace.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.
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CREATING HDR IMAGES

This tutorial explains how to use AKVIS HDRFactory to obtain an HDR-image from a series of shots taken with different
exposure settings.

Step 1. Run the standalone edition of AKVIS HDRFactory or your photo editor (if you work with the plugin version of
AKVIS HDRFactory), and open a set of images.

To load a set of images in the plugin or in the standalone program click on  and select all images holding down the

Ctrl -key.

Under the image window you can see thumbnails of the opened files. The image which is selected with a blue frame is
shown in the Before tab.

Set of Images

Hint: Learn how to get a series of shots with different exposure settings using a digital camera.

Attention! If the shots do not contain any exposure information you will see the Set Exposure Value dialog box
(the hot-keys for the command Ctrl+Е ) where you can enter the values manually.

At first the program calculates exposure for every shot automatically; then you can change the values either by
selecting the exposure step in the drop-down menu or by entering arbitrary values.

The Reset button restores the automatically calculated exposure values.

The Apply button opens the images taking into account the set exposures.

The Cancel button closes the dialog box.

Step 2. The photos will be automatically processed to build an HDR image with the last used parameter values (the first
time - with the default values). The result will be shown in the After tab.
Step 3. Select the value of the Preview parameter. It’s an auxiliary tool, it does not influence the real size of the
image.
Step 4. Adjust the alignment quality of the images by selecting one of the following options: Fast alignment, Normal
alignment and High-quality alignment. The better the alignment quality, the longer the processing time will be. We
recommend Normal alignment. If you are sure that there is no shift in the image series choose No alignment.
Step 5. Select one of the AKVIS presets or adjust the parameters as you like:

Saturation (-50..50). The parameter changes the color intensity of the image.
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Saturation = -50

 

Saturation = 50

 

Tonal Contrast = 5

 

Tonal Contrast = 50

 

Level of Detail = 10

 

Level of Detail = 40

Tonal Contrast (0-50). The parameter changes brightness in gradient areas.

Level of Detail (0-50). The parameter defines the amount of details. High values may cause noise.

Soft Focus (1-15). The parameter aligns the image's color and brightness. It reduces the effect of other
parameters.
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Soft Focus = 1

 

Soft Focus = 10

 

Highlights = -30

 

Highlights = 30

 

Shadows = -30

 

Shadows = 30

Highlights (-50..50). The parameter adjusts the lightness of the light areas of the image. Reduce the value to
make the light areas darker, increase to make them lighter.

Shadows (-50..50). The parameter adjusts the lightness of the dark areas of the image. Reduce the value to
make the shadows darker, increase to make them lighter.

Lightness (0-100). The parameter changes the overall lightness of the image and helps to illuminate it.
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Lightness = 25

 

Lightness = 75

Image processing starts automatically and any changes are displayed in real time, in the After tab.

 

Result

Note: It's possible to apply additional effects to your High Dynamic Range image using the Adjustment and Effects
tabs.

With the Home Deluxe/Business license, you can also use the Ghost Removal  and Local Correction  modes.

Step 6. If you like the new settings you can save them as a preset and use them later. To save the settings, enter a
name for the preset in the Presets field and press the button Save.
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GHOST REMOVAL IN HDR IMAGES

To create an HDR image, we need to take a series of photos with different exposures. However, while shooting, especially on
a busy street, random objects (cars, people, or animals) can pass through the frame. Their appearance in each photo will be
a little different. After the photos are combined, these objects will appear in various places, and due to the transparent
nature of these "ghosts", the background will show through them.

Not so long ago, removing these artifacts was a time-consuming procedure. It required a graphics editor and a large amount
of time.

Now "ghosts" can be dealt easily with AKVIS HDRFactory. Watch a Video Tutorial.

Attention! This feature is only available for the Home Deluxe and Business licenses.

To remove ghosts from the resulting HDR-image follow these steps:

Step 1. Activate the Ghost Removal mode  and choose the tool .

Step 2. Right-click on the image to access the tool's menu where you can change the tool size and select one of the
original images to be used as a source for the problem areas ("ghosts").

It's recommended to choose one with the best exposure, where the object is well-visible.

Step 3. Draw over the "ghosts" with . It's better to select an area a bit larger than the defects.

Note that you can use the tool only on the result in the After tab.

The process starts automatically after using the Ghost Removal tool  but when the area is highlighted it's hard to

see the changes.

To see the result just hide the selection by clicking on .
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If you are not satisfied with the result, you can edit the selection with the Eraser  or choose another source

image.
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ADJUSTMENT AND SINGLE-SHOT HDR EFFECT

The Adjustment tab lets you improve a photo or create an HDR effect from one single image.

We need several photos of one scene, taken at different exposures, to create an HDR image. But sometimes it's impossible
(for example, the camera does not have bracketing mode or it's not possible to stabilize the camera). Therefore often there is
only one photo, whose details in dark and light areas are hidden. For example, a picture can have a well-defined landscape
but a bright, white, featureless sky.

Use the parameters of this tab to reveal details in the darkest and brightest areas, to give an image depth, and increase
color saturation. It can help you whether you want to make small corrections or give your image a dramatic HDR look.

Note: When creating a real HDR image from a set of photos in HDRI tab, you can use the Adjustment tab as the 2nd step,
to make additional corrections.

Step 1. The photo will be automatically processed. The result will be shown in the After tab.

 

Image Adjustment with Default Settings

Step 2. Select the value of the Preview parameter. It’s an auxiliary tool, it does not influence the real size of the
image. The original image will stay the same and all details of the original image will be kept.

AKVIS HDRFactory

35



 

Tone Correction = 20

 

Tone Correction = 70

 

Depth = 1

 

Depth = 100

Step 3. You can use one of the standard presets or adjust the settings as you like:
Tone Correction (0-100). The degree of change in the brightness of an image with respect to its surroundings.
Dragging the slider to the right increases the impact of this parameter. It can reveal details in overexposed or
washed-out areas.

Depth (1-100). This parameter affects the depth of the image. When it is increased the picture becomes more
voluminous.

Attention! If Tone Correction is 0, changing Depth will have no affect on the image.

We recommend you firstly adjust Tone Correction, then little by little change Depth to get details in both
light and darks areas. If you are not satisfied with the result, change the first parameter and then the
second one.
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Gradient Contrast = -50

 

Gradient Contrast = 50

 

Smoothing = 15

 

Smoothing = 150

Gradient Contrast (-100..100). This parameter affects contrast in gradient areas. When you move the cursor to
the right from 0, the contrast increases, and when to the left, the contrast reduces.

Smoothing (0-200). High values for the first two parameters can reveal noise. This parameter helps to reduce
noise while not significantly affecting the clarity of boundaries. If this parameter is set to a high value the image’s
volume decreases.
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Local Contrast = -50

 

Local Contrast = 50

 

Color Intensity = 10

 

Color Intensity = 60

Local Contrast (-100..100). This parameter increases the difference between pixels on the edges of the light
and dark areas, it strengthens the details giving them a volume. This local change in contrast mainly affects
midtone areas. As this parameter is increased the image becomes sharper.

Color Intensity (0-100). Increasing this parameter increases the intensity of all colors in the image. At higher
values this may cause noise. If the photo was processed before in other programs, and the original color
information was lost, using this parameter could cause an unexpected result. It could, for example, lead to a
decrease in the intensity of color in some areas of the picture.
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Remove Noise = 0

 

Remove Noise = 10

Remove Noise (0-25). The parameter lets removing noise and defects by increasing the level of smoothness.
The higher the value, the smoother the result is.

Image processing will start automatically and any changes will be displayed in real time, in the After tab.

Here is the result:

 

Result

Note: It's possible to apply additional effects to the image using the Effects tab.

With the Home Deluxe/Business license, you can also use the Local Correction  mode to refine the result on

certain areas.

Step 4. If you like the new settings you can save them as a preset and use them later. To save the settings, enter a
name for the preset in the Presets field and press the button Save.
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Original Image

 
Result

LOCAL CORRECTION

With the Home Deluxe/Business license, the Local Correction mode  is available. In this mode, you can refine the result

on certain image areas.

 

Mark areas that require additional processing using the tools on the Toolbar. You can choose between two local correction
tools:

Pin Tool . The tool allows to perform local correction within an elliptical area. Add pins by clicking on the image with

the left mouse button. Adjust the size and shape of the correction area using the following markers:

- external line helps to limit the correction area of the selected pin; 
- internal line determines the smoothness of the transition between the correction area and the non-correction
area; 
- dots are used to rotate, stretch, or compress the correction area.

To move the pin, place the cursor on it (it will turn into crossed arrows ) and drag holding down the left mouse

button. To resize any section, put the cursor on the line bounding this area (it will look like a double arrow ) and
drag with the left mouse button. Right-click on the pin to adjust the correction settings. To remove the pin, press the
Delete  key.

Correction Area . Using the tool, you can mark large areas of arbitrary shape and size. Each area can be

processed with its own settings. You can easily edit or remove the selection with the Eraser . Right-click in the

Image Window to adjust the tool size. Right-click on the correction area to open a pop-up box with processing
parameters.

Use /  to show/hide all pins and selections.
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Exposure = -50 Exposure = 50

Saturation = -50 Saturation = 50

Contrast in Shadows = 10 Contrast in Shadows = 100

To change the processing parameters, call the pop-up box by right-clicking on the pin or selection.

Show Selection. Disable the check-box to hide the selection and view the image.
Exposure (-100..100). If the exposure is too low, the image becomes dark with the lack of details in shadows, if it's
too high - the image lightens up with loss of detail in light areas.

Saturation (-100..100). The parameter changes the color intensity.

Contrast in Shadows (0-200). The parameter makes dark areas even darker.

Contrast in Highlights (0-200). The parameter makes light areas even lighter.
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Contrast in Highlights = 50 Contrast in Highlights = 150

Temperature = -50 Temperature = 50

Details = 0 Details = 500

Temperature (-100..100). The parameter makes the image colder or warmer. Moving the cursor to the left of 0
increases the number of cool (blue) tones, while moving it to the right of 0 increases the number of warm (yellow)
tones.

Details (-100..500). Increasing the parameter sharpens the image. If the value is less than 0, the image is blurred.

Threshold (0-100). The parameter determines pixels to be processed.
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Threshold = 5 Threshold = 50

Transition = 30 Transition = 80

Radius = 100 Radius = 1000

Transition (0-100). The parameter creates a smooth transition between adjacent pixels.

Radius (0-5000). The parameter lets you increase the processing area spreading the effect beyond the selection.

Any changes of the parameters are applied automatically. Click the Default button to return all settings to their default
values.
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Result
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EFFECTS

Using the Effects tab you can adjust image hues, add warm or cold tints, apply a soft glow effect, darken or lighten the
image edges and highlight the main objects in a scene.

Step 1. The photo will be automatically processed with the last used parameter values. The result will be shown in the After
tab.

 
Result With Default Settings

Step 2. Select the value of the Preview parameter. It's an auxiliary tool, it does not influence the real size of the image. The
original image will stay the same and all details of the original image will be kept.

Step 3. Select one of the AKVIS presets or adjust the parameters as you like:

The parameters under White Balance help correct color hues and change the mood of a photo by adjusting its cool or warm
tones.
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Temperature = -50

 

Temperature = 50

 

Tint = -50

 

Tint = 50

Temperature (-100 to 100) makes the image colder or warmer. Moving the cursor to the left of 0 increases the number
of cool (blue) tones, while moving it to the right of 0 increases the number of warm (yellow) tones.

Tint (-100 to 100) adjusts the tint of the image. The default value is 0. Negative values for this parameter give the
image a green hue while positive values add magenta to the image.
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Dark Edges

 

Light Edges

Glow adds a soft glow effect by creating a blurred layer above the source image. When these layers are blended together it
results in a surreal appearance.

Intensity (0-100) defines the strength of the glow effect.

Glow Effect

The parameters under Vignette lighten or darken the edges of the photo. This effect helps centrally located objects to be
the focus of the image.

Color. Choose the color of the vignette. Adjust the amount of color with the Intensity parameter (0-100).
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Distance = 5

 

Distance = 50

 

Shape = -50

 

Shape = 50

 

Smooth Transition = 10

 

Smooth Transition = 50

Distance (0-100) determines how far from the center of the image shading will begin.

Shape (-100 to 100) affects the form of the unshaded area of the image. At negatives values it takes the form of a
rectangle with rounded edges, while at positive values it takes the form of a circle.

Smooth Transition (0-100) adjusts the smoothness of the boundary between the shaded area and the central part.
Increasing the value increases the fading effect.
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Position. Move the white marker to shift the vignette. You can see the current coordinates of the center in the X and
Y fields.

Moving Vignette

Processing starts immediately after any parameter is adjusted, and any changes are displayed in real time, in the After tab.

Here is our result:

 

Result

Step 4. If you like the new settings you can save them as a preset and use them later. To save the settings, enter a name
for the preset in the Presets field and press the button Save.
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CROP TOOL

The Crop tool  allows cutting off unwanted areas in the created HDR image and reducing its size. It lets you improve the

composition, align the edges in a crooked photo, make a square from a rectangular or contrariwise.

This tool is available in the standalone version of HDRFactory. To quickly access it use Alt+C .

 

Defining a Crop Area

The rectangular frame shows the image which will be saved as a result. All parts outside of the frame will be cut out. By
default, the entire image is selected.

You can change the crop area by dragging the sides and the angles of the bounding frame. To constrain the proportions use
the Shift -key.

The new image size and the tool's options are displayed in the Settings Panel.

Note:

You can't enlarge the image size, only reduce it.

The Vignette and other effects will be applied to the new size.

To move the frame, place the cursor  inside it and drag holding down the left mouse button.

To rotate the area, place the cursor  outside the frame, and move it with the left mouse button. If you press Alt , the

rotation angle will change in 5 degrees.

To apply the result and remove the areas outside the frame, press OK in the Settings Panel or use Enter .

To cancel the operation and exit the tool, press Cancel or use the Esc -key.

To restore the original area keeping the tool active, press Reset button in the Settings Panel.

 

The tool settings are displayed in the Settings Panel.

In the drop-down list, select the Ratio to which you want to crop the picture. If you would like your image to be cropped to
a specific ratio, select the Custom option and enter the values in the input fields. Click on  to rotate the crop frame by

90o.
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Ratio = 1:1

 

Ratio = 3:4

 

Check-box is disabled

 

Check-box is enabled

 

You can customize the visualization of the removable parts.

If the External Area check-box is enabled, the outer parts are highlighted in a selected color.
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Yellow

 

White

 

Opacity = 20

 

Opacity = 60

Adjust the visualization options:

Color. Click on the color square to open the Select Color dialog box.

Opacity (1-100). The parameter defines the transparency of the highlight color.
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POST PROCESSING

For further image correction you can use Post Processing. It is available only in the standalone edition because any image
editor offers these features, so there is no reason to use this section in the plugin.

The panel includes a Histogram and four adjustable parameters: Brightness, Contrast, Gamma, and Saturation.

A Histogram is a graph that shows the tonal range of an image. On the horizontal line the brightness values are set from the
darkest to the lightest. The vertical line sets the number of pixels having this lightness value.

Below the histogram there are three sliders that can be moved to change the image contrast.

The extreme point on the right end represents pixels having the maximum brightness (white points). If the histogram does not
have such pixels, the image does not contain any white points. If we move the white slider to the left, the point against
which the slider is located will assume the maximum brightness (255) and the pixels having this value will become white. The
brightness of other pixels will be re-calculated accordingly. The image will get lighter.

The extreme point on the left end represents pixels having the minimum brightness (black points). If the histogram does not
start at the left end, the image does not have any black pixels (brightness = 0). If you move the black slider to the right, the
point against which the slider is located will assume the minimum brightness value. As a result this tone will become black,
while other pixels will be re-calculated accordingly. The image will get darker.

The middle slider defines the tone of the image that will have the brightness of 128 (middle-gray tones). If you move the
slider to the left, the mid-gray tones get lighter; if you move the slider to the right, the mid-gray tones get darker.

Near the histogram is a drop-down list with image channels (RGB, Red, Green, Blue, Colors, Luminosity). It is possible to
adjust every channel separately or correct a combined channel.

 

The Post Processing panel also contains parameters that correct the brightness and contrast of the image, make gamma-
corrections and change the saturation of the image.

Brightness (-100..100). The parameter is used to change the image brightness. The higher is the value of the
parameter, the lighter all pixels are, and vice versa.

Contrast (-100..100). The parameter is used to increase (if the value is over 0) or reduce (if the value is under 0) the
difference between bright and dark parts of the image.

Gamma (50-250). The parameter is used to change the overall contrast of the image by increasing or reducing mid-
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tones and gray mid-tones.

Saturation (-100..100). The parameter is used to change the intensity of colors.

As you adjust the settings, processing is started automatically. The result is shown in the After tab.
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BATCH PROCESSING

AKVIS HDRFactory supports the Batch Processing feature that lets you automatically convert a series of images with the
same settings and saves you time and efforts. It is useful when creating a number of illustrations at the same style for a
booklet or when processing all frames of video.

 

Even if you've never used this feature before it is simple to learn!

If you use the standalone version of AKVIS HDRFactory, read the instructions here.

If you use the HDRFactory plugin in Photoshop, use this tutorial.
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BATCH PROCESSING WITH PHOTOSHOP PLUGIN

The AKVIS plugins support the automation feature in Adobe Photoshop.

Batch processing is very useful and time saving when you have to apply the effects to a number of photos. This method
applies the same settings to a folder full of images.

Even if you have never used batch processing you will find no difficulties in understanding it. First you create an Action in
Photoshop and then apply it to a photo folder.

Follow the instructions:

Step 1. Create two new folders, for example: "source-files" and "result-files". Place original images into the "source-
files" folder. The results will be saved in the "result-files" folder.
Step 2. Open one of the original images in Adobe Photoshop. We will use this photo to adjust the plugin's settings and
create an action.

Step 3. In the Actions palette click Create New Set button. In the dialog window give a name for a new set of
actions, for example, "AKVIS".

If you already have a special set for the AKVIS actions, you can just choose it.

Actions Palette

Step 4. Press Create New Action and give a name for it, for example, "Oil".
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New Action

Press the Record button, and the recording of the action will immediately start.

Step 5. Call the plugin and adjust its parameters.
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Step 6. Press the button . The plug-in window will close and the effect will be applied to the image. In the Actions

palette, in your new action, you will see a new line with the plugin's name.

Step 7. Remember that the action is still being recorded. Now, you should save the image. Choose Save As in the File
menu and save the image into the destination folder.
Step 8. Stop the action recording by pressing Stop playing/recording at the bottom of the Actions palette.

Step 9. Delete the file that you have just saved.
Step 10. The action is created and you can proceed to batch processing of the photos.

In the File menu of the editor choose Automate -> Batch.

Step 11. In the Batch dialog window and set the parameters:
In the Set drop-down list choose "AKVIS" and the new action.
In the Source option set Folder. Press the Choose… button and select "source-files".
As the Open command was not recorded in the action, the Override Action "Open" Commands check-box
should be deactivated.
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For Destination select Folder, then press the Choose… button and select "result-files".
Activate Override Action "Save as" Commands check-box.
In the File Naming section you can create the filenames structure for the resulted images. If you do not want to
change the names, in the first combo-box choose document name, and in the second - extension.

Step 12. Press OK to start processing. Photoshop will apply the AKVIS plugin to all photos in the "source-files" folder,
one by one, and will save them to the "result-files" folder.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box. It looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Scale. This parameter defines the way the image is scaled in the Image Window after opening. The parameter
can take one of two values:

- image scaling Fit to View. The scale adjusts so that the image will be completely visible in the Image
Window; 
- if the option 100% is checked, image doesn’t scale. Generally, when the scale = 100%, only part of the image
will be visible.

Recent Files (available only in the standalone version). The number of recent documents. The list of the recent files
(single images or HDR-sets), sorted by time, become visible by right mouse clicking on . Maximum: 30 files.

Hints Panel. When you hover over parameters and buttons with the cursor you can see a brief description of them in
the Hints field. You can choose how the hints will be shown:

- Under Settings Panel. Select this to show hints at the bottom of the right part, under the settings; 
- Under Image Window. It shows the hints in the main window, under the image. This mode is useful if there is
not enough space by height to display this field under the settings; 
- Hide. Use this option if you do not need the hints.

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected
the panel is always visible. Uncheck the option to unlock the panel, and you will be able to hide/show it by clicking on
the small triangle button (in the middle of the panel). The minimized panel will be shown when moving the cursor over it.
Use GPU. The check-box lets you turn on GPU acceleration. If your computer does not support GPU acceleration the
check-box will be disabled.

To save changes made in the Preferences window press OK.

If you need, click on the button Default to come back the default settings.
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PRINT IMAGES IN AKVIS HDRFACTORY

In the standalone version of AKVIS HDRFactory you can print the image. Press the button  to open the Print options.

Print Options in AKVIS HDRFactory

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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SUNSET BEACH: CREATING AN HDR EFFECT ON A PHOTO

When photographing a beautiful landscape, you want the picture to be as colorful and realistic as in real life. But usually the
result is a huge disappointment. On a monitor, a bright and rich landscape looks washed out and lifeless.

AKVIS HDRFactory can help you turn an ordinary photograph into a fantastically beautiful and vivid picture.

Let's try to give a photograph a HDR look:

Step 1. Start the standalone version of AKVIS HDRFactory. We open an image and see a gray sea, gray skies, and a
pale strip of sunset.

Step 2. After the program has been started the photograph will be processed using the default settings. The result will
be shown in the After tab.
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The image now looks better. There are reflections of the sunset on the sea, the sky has began to take on a crimson
hue, and some details have become visible. Let's try to achieve an even more brilliant effect.

Step 3. Experiment with the settings: increase the value of Tone Correction, Depth and Color Intensity.

The resulting image is more colorful and realistic. Objects in the image acquired the desired qualities, and colors became
brighter and more saturated.

You can save the settings as a preset to use them later with other images.
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HIGHLANDS SCENERY: GENERATING AN HDR IMAGE

The photos have been sent to us by Denis Davydov.

Denis sent us a series of shots under different exposures. The scenery is really beautiful. However, the colors are dark and
some objects are hardly visible because they are not illuminated. Using AKVIS HDRFactory you can reveal details and
improve color saturation.

   
Source photos

 
Result: HDR image 

Learn how to achieve this result below:

Step 1. Launch the program AKVIS HDRFactory.
Step 2. Press the button  in the Control Panel of AKVIS HDRFactory and select the required files.

Images will be loaded into the program and processed automatically using the default parameters (in this case it is the
AKVIS Default preset).

Step 3. Adjust the Tone Mapping settings.
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The result is good. You can save the result by pressing the button . But our goal is to make this image brighter and

reveal some objects in the shadows.

Step 4. We can add volume to the objects by using the Adjustment tab.

You can set the values as shown in the screenshot.

Step 5. The image has become too light. We can make it more intense and saturated.

Switch to the Post Processing parameters and set Brightness = 15, Saturation = 40, Gamma = 90.
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You can compare one of the original images and the result by switching between the Before and After tabs.

Step 6. We got what we wanted. The resulting image looks great: it's acquired texture, became more intense, and is
full of sunshine. Small details and new tints were revealed, and the background is now more voluminous and expressive.

Press the button  to save the result.
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
quality of compressed images. This program provides 4 image enhancement modes, each involves a unique neural network
developed especially for this occasion. The software is available free of charge for home users. For commercial use, a
Business license is offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any
picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage AI — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style
of a selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load
a custom sample. Imitate the style of world famous artists! More…
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AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…

AKVIS HDRFactory

75

https://akvis.com/en/makeup/index.php?utm_source=help
https://akvis.com/en/natureart/index.php?utm_source=help
https://akvis.com/en/natureart-tutorial/effects/rain.php?utm_source=help
https://akvis.com/en/natureart/index.php?utm_source=help
https://akvis.com/en/neon/index.php?utm_source=help
https://akvis.com/en/neon/index.php?utm_source=help


 

AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…
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AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…

 

AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…
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AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist!
More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…
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AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…
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